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ChilliDB – Reporting Interface

Introduction to Reporting
· Polymorphic Solutions Reporting Views - Polymorphic Solutions provide a reporting layer to our database using Database.  

Views.  Our reporting views are prefixed with “rpt_”.  While there may be some deprecated (obsolete) reporting views present  
within the database, they will in time be removed.  Those deprecated views are named with a "v_" prefix.  You should avoid  
using those, and migrate any reports you may have to use the "rpt_" reporting views.

· Creating your own Customised Views: When the Polymorphic Solutions Reporting Views aren’t sufficient for your needs, 
you may choose to create custom database views, tables, or stored procedures (collectively referred to as Database Objects)
within your database.  To ensure that updates to the system do not overwrite your customised database objects, Polymorphic 
Solutions recommends that you prefix your custom Database Objects with a prefix. We recommend using your organisation 
prefix.  For example a view showing Contacts in Brisbane for a company called “ACME Inc” would use create a view named 
“acme_Contacts_In_Brisbane”.  The "rpt" prefix is reserved and should not be used for your custom reporting views.

· Automatic View Generation – Dynamic Data automatically generated Reporting Views for each “Section” of Dynamic Data.
Custom “Address” and “Communication” types do not automatically generate Reporting Views.  If you create custom 
“Address” and “Communication” types you need to use ChilliDB to refresh your reporting views by navigating to the ChilliDB “Reports” 
menu > “Reporting View Maintenance” > “Reporting Views” menu item.

· Report Branding – Using information from the Crystal Report branding view to display your company details will allow you to easily
share your reports with other ChilliDB users in the community. You can configure the information displayed in this view by selecting 
“Reports” -> “Report Branding” from the ChilliDB menu.  From that screen you configure your display name, address details, privacy 
or confidentiality statement and even upload your Division logo image to be included in your reports.  

· Modifying or Copying Polymorphic Solutions Reports: You are free to modify the Polymorphic Solutions reports and 
customise them to suit your needs.  To avoid them being overwritten, you should make a copy and give them a different name.

· Filtering out Expired records: ChilliDB records a date in the “Expired” field of “Contacts” and “Organisations” reporting views as a 
datetime value, meaning if a datetime is present, that record is expired.  If it is not expired, it be NULL.  Example formulas for 
“Contacts” and “Organisations” would be: IsNull ({rpt_Contact.Expired}) for Contacts, IsNull ({rpt_Organisations.Expired}) 
for Organisations. Filtering out expired records can also be performed by utilising “Is Expired” field of “Contacts” and “Organisations”
reporting views. The field is storing “Yes” or “No” value to indicate if the Contacts or Organisations have expired. Some other 
reporting views may present “Expired” and “Is Expired” fields if their records are allowed to be expired.

· Date Time Values are stored in Greenwich Mean Time (GMT) time: With 2.5.0, it was necessary for ChilliDB to switch the 
database date time data from storing date times values in localised time to storing them in Greenwich Mean Time (GMT). 
All our “rpt_” reporting views automatically convert the GMT date time values to localised date time values for you. If you report off 
database directly, you should obtain a copy of the document called “Fact Sheet – 2.5.0 Timezone Support and Reporting off of Tables
instead of Views” for further instructions.

Using/Configuring Crystal Reports
· Connection Details – When your ChilliDB installation is complete, Polymorphic Solutions send an “Installation Complete” email

which contacts all the information needed to connect to your database server (i.e. Server name, Username, Password, Database 
name).

· Database Connections – Creating: Crystal Reports should be written using OLE DB (ADO) to connect to your SQL Server.  
Do not use ODBC.

· If you have Crystal Reports Version 9: Crystal Reports 9 forces the parameters in your reports to be mandatory, 
so you cannot leave parameters blank.  If you do not want your reports to always filter on criteria, you should modify 
your reports Record Selection to handle entering values like "-" or "-1" or "01 Jan 1900" to signify no value, and enter those 
values as criteria.  Version XI or better do not place any such limitations on the parameters used in your reports.

· Crystal Reports – Automatic Smart Linking: We recommend that you avoid using the “Auto Link” feature within the Crystal  
Reports Database Expert.  What it will do is try to link tables/views based on their field name or data types, however it often 
this is not correct and can lead to missing data or incorrect data shown in your report.  You can set this as your preference when 
writing all reports in Crystal by going to “File” menu > “Options” > “Database” tab of the popup which appears > set 
“Automatic Smart Linking” to off.

· Crystal Reports  - Save Data With Report: This feature will allow the report to cache data shown in the report from the 
database when writing the report.  When ChilliDB runs the report, it shows the cached data, not live data.  It is best if you disable
this preference through the “File” menu > “Options” > “Reporting” tab of the popup which appears > set “Save Data With Report”
to off.  If you decide to use Saved Data while authoring your report, you can check the status or enable/disable this feature from 
the “File” menu >“Save Data with Report”.  If you receive a report from someone, you should check this option is off before 
uploading into ChilliDB.

· Crystal Reports - No Printer: We recommend turning this option off to increase the speed of displaying reports in ChilliDB.
You need to do this for each report you write (i.e. its not a configuration option).  This option is found on the “File” menu
> “Page Setup” > “Printer Options” sections of the popup window which appears > set “No Printer (optimized for screen display)”
to being checked.
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Base Organisation Information

Views: rpt_Organisation
rpt_Organisation_History
rpt_Organisation_Standards
rpt_Organisation_Relationship
rpt_Organisation_Base_Section

Notes:

· Organisations are expired, not deleted. Expired organisations will have a value in the “Expired” field.

· The rpt_Contact_Base_Section is generated by the application and may contain some Dynamic Data fields.

Preferred Mailing Address

View: rpt_Organisation_Preferred_Mail_Address

Business Phone, Fax and E-mail Communication

Views: rpt_Organisation_Business_Phone_Communication
rpt_Organisation_Business_Mobile_Communication
rpt_Organisation_Business_Fax_Communication
rpt_Organisation_Business_E-mail_Communication

Home Phone, Fax and E-mail Communication

Views: rpt_Organisation_Home_Phone_Communication
rpt_Organisation_Home_Mobile_Communication
rpt_Organisation_Home_Fax_Communication
rpt_Organisation_Home_E-mail_Communication

Business Address

View: rpt_Organisation_Business_Mail_Address
rpt_Organisation_Business_Physical_Address

Home Address

View: rpt_Organisation_Home_Mail_Address
rpt_Organisation_Home_Physical_Address

Dynamic Data Sections

Views: rpt_Organisation_*_Section

Notes:

· These views are generated by the 
application and will be named to match the 
“Section Description”.

· Multiple lookup fields will be formatted to a 
comma-separated list

Notes and Resources

Views: rpt_Organisation_Note
rpt_Organisation_Resource

Other Address Types

Views: rpt_Organisation_*_Address

Notes:

· These views are generated by the application and will 
be named to match the “Address Type” value.
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Link using “Organisation Id” field

Link using “Organisation Id” field

Organisation Information

Other Communication Types

Views: rpt_Organisation_*_Phone_Communication
rpt_Organisation_*_Fax_Communication
rpt_Organisation_*_Email_Communication
rpt_Organisation_*_Communication (obsolete)

Notes:

· These views are generated by the application and will be named 
to match the “Communication Type” value.

· The old “rpt_Organisation_*_Communication” views will still be 
available to use but will be marked as obsolete and phased out 
gradually in future releases.

· If there are similar Communication Type name found in two or 
more Communication Categories, the 
rpt_Organisation_*_Communication for that type will not be 
generated.

Link using “Organisation Id” field
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Base Contact Information

Views: rpt_Contact
rpt_Contact_Privacy
rpt_Contact_Base_Section

Notes:

· Contacts are expired, not deleted. Expired contacts will 
have a value in the “Expired” field.

· The rpt_Contact_Base_Section is generated by the 
application and may contain some Dynamic Data fields.

Preferred Mailing Address

View: rpt_Contact_Preferred_Mail_Address

Notes:

· Contacts inherit detail from their Primary Organisation. 
“Address Is Inherited” field will contain “True” or “1”.

Business Phone, Fax and E-mail Communication

Views: rpt_Contact_Business_Phone_Communication
rpt_Contact_Business_Fax_Communication
rpt_Contact_Business_E-mail_Communication

Notes:

· Contacts inherit detail from their Primary Organisation. 
“Address Is Inherited” field will contain “True” or “1”.

Personal Phone, Fax and E-mail Communication

Views: rpt_Contact_Personal_Phone_Communication
rpt_Contact_Personal_Mobile_Communication
rpt_Contact_Personal_Fax_Communication
rpt_Contact_Personal_E-mail_Communication

Contact and Organisation Association

View: rpt_Contact_Organisation

Business Address

View: rpt_Contact_Business_Mail_Address
rpt_Contact_Business_Physical_Address

Notes:

· Contacts inherit detail from their Primary Organisation. 
“Address Is Inherited” field will contain “True” or “1”.

Home Address

View: rpt_Contact_Home_Mail_Address
rpt_Contact_Home_Physical_Address

Dynamic Data Sections

Views: rpt_Contact_*_Section

Notes:

· These views are generated by the application 
and will be named to match the “Section 
Description”.

· Multiple lookup fields will be formatted to a 
comma-separated list

Other Address Types

Views: rpt_Contact_*_Address

Notes:

· These views are generated by the application and will 
be named to match the “Address Type” value.

Link using

“Contact Id” field
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Link using “Contact Id” field

Contact Information

Link using “Contact Id” field

Link using “Contact Id” field

Link using “Contact Id” field

Other Communication Types

Views: rpt_Contact_*_Phone_Communication
rpt_Contact_*_Fax_Communication
rpt_Contact_*_Email_Communication
rpt_Contact_*_Communication  (obsolete)

Notes:

· These views are generated by the application and will 
be named to match the “Communication Type” value as 
well as the “Communication Category” group name.

· The old “rpt_Contact_*_Communication” views will still 
be available to use but will be marked as obsolete and 
phased out gradually in future releases.

· If there are similar Communication Type name found in 
two or more Communication Categories, the 
rpt_Contact_*_Communication for that type will not be 
generated.

Roles, Notes and Resources

Views: rpt_Contact_Role
rpt_Contact_Note
rpt_Contact_Resource

Link using

“Contact Id” field
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Base Note Information

Views: rpt_Note
rpt_Note_File_Attachment
rpt_Note_Base_Section

Notes:

· “Text” field contains a plain text version of the note 
content. “HTML Text” is the original version with fonts 
and formatting in HTML format.

· The rpt_Note_Base_Section is generated by the 
application and may contain some Dynamic Data fields.

Contact and Organisation Association

View: rpt_Note_Contact_Organisation

Dynamic Data Sections

Views: rpt_Note_*_Section

Notes:

· These views are generated by the application and 
will be named to match the “Section Description”.

· Multiple lookup fields will be formatted to a 
comma-separated list

Link using

“Note Id” field

Note Information

Link using “Note Id” field
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Base Event Information

View: rpt_Event

Calendar Style List

View: rpt_Event_Calendar

Dynamic Data Sections (For Event)

Views: rpt_Event_*_Section

Notes:

· These views are generated by the application and 
will be named to match the “Section Description”.

· Multiple lookup fields will be formatted to a 
comma-separated list

Link using

“Event Id” field

Event Information
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Link using “Event Id” field

Sessions

View: rpt_Event_Session

Attendees/Registration

View: rpt_Event_Attendee
          rpt_Event_Registration

Statistics

View: rpt_Event_Statistics

Dynamic Data Sections (For Session)

Views: rpt_Event_Session_*_Section

Notes:

· These views are generated by the application and 
will be named to match the “Section Description”.

· Multiple lookup fields will be formatted to a 
comma-separated list

Dynamic Data Sections (For Registration)

Views: rpt_Event_Registration_*_Section

Notes:

· These views are generated by the application and 
will be named to match the “Section Description”.

· Multiple lookup fields will be formatted to a 
comma-separated list

Link using “Session Id”

Link using 

“Attendee Id / Registration Id”

field

Link using

“Session Id”

field

Link using “Session Id”
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Base Appointment Information

View: rpt_Appointment

Appointments

Dynamic Data Sections

Views: rpt_Appointment_*_Section

Notes:

· These views are generated by the application and 
will be named to match the “Section Description”.

· Multiple lookup fields will be formatted to a 
comma-separated list

Link using “Appointment Id” field

Appointment Attendees

View: rpt_Appointment_Attendee

Link using

“Appointment Id”

field

Base News Information

View: rpt_News

News

Distribution List Information

View: rpt_Distribution_List

Distribution Lists

List Members

View: rpt_Distribution_List_Member

Link using

“Distribution List Id”

field

Quick Link Information

View: rpt_Quick_Link

Quick Link
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Base Survey Information

View: rpt_Survey

Survey Module

Questions

View: rpt_Survey_Question

Responses

View: rpt_Survey_Response

Answers

View: rpt_Survey_Answer

Link using

“Survey Id”

field

Link using “Response Id” field

Link using

“Question Id”

field

Link using “Survey Id” field

Base Asset Register Information

View: rpt_Asset_Register_Details

Asset Register Module

System Owner Detail

View: rpt_System_Owner

System Information

Role Details

View: rpt_System_User_Role

Security Ticket Details

View: rpt_System_Role_Ticket

User Details

View: rpt_System_User

Link using “Role Id” field

Link using

“Role Id”

field

Link using

“Role Id”

field

Report Branding Details

View: rpt_Report_Branding

Report Branding

mailto:productsupport@polymorphicsolutions.com.au


ChilliDB
Version: 2.7.n

Last Updated: 29 Sep 2011

Reporting Interface Documentation

Copyright. Polymorphic Solutions Pty Ltd Product Support Team. 
support@chillidb.com

Page 9 of 16

Project Information

Views: rpt_Timesheet_Project

Assignments

View: rpt_Timesheet_Assignment

Timesheet Module

Link using

“Project Id”

field

Assignment to User Association

View: rpt_Timesheet_User_Assignment

Link using “User Id” field

Booked Time Blocks

View: rpt_Timesheet_Time_Block

Link using

“Assignment Id”

field

Master Order Information

Views: rpt_Order_Master
rpt_Note_File_Attachment

Notes:

· “Master Orders” are groups of Purchase Orders 
which were created at the same time.

Purchase Order Header

View: rpt_Purchase_Order_Header

Orders Module

Link using

“Order Master Id”

field

Order Line Items

View: rpt_Purchase_Order_Line

Link using “Purchase Order Id” field

Product Information

View: rpt_Order_Product

Link using

“Product Id”

field

Patient Information

Views: rpt_Ataps_Patient
rpt_Ataps_Patient_Flat

Notes:

· The “_Flat” view contains extra 
information usually available by 
linking other views.

ATAPS Module

Session Information

Views: rpt_Ataps_Session
rpt_Ataps_Session_Flat

Notes:

· The “_Flat” view contains extra information 
usually available by linking other views.

Treatment Blocks

View: rpt_Ataps_Treatment_Block

Diagnostic, Medication and Referral 
Information

Views: rpt_Ataps_Patient_Primary_Diagnostic_Category
rpt_Ataps_Referred_For_Strategy
rpt_Ataps_Psychotropic_Medication_At_Referral
rpt_Ataps_Psychotropic_Medication_At_Closure

Session Strategies

View: rpt_Ataps_Session_Strategy_Provided

Link using

“Session Id”

field

Link using

“Block Id”

field

Link using

“Patient Id” field

Link using

“Patient Id” field

Link using

“Patient Id” field
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Data Mining module reporting views are automatically generated for every Data Mining Search and Data Mining Data Set item stored in 

the ChilliDB system. 

For example: 

If you have created a Data Mining Search or Data Set item called “Something”, then a reporting view called “rpt_Data_Mining_Something” 

will be created automatically in the system containing all the reporting field definitions defined for the Data Mining Search item. 

Note: 

In order to generate the reporting view, you must ensure that the Data Mining Search or Data Set item has at least a Column defined in 

the Display Columns section (for Data Mining Search screen) or in the Columns section (for Data Mining Data Set screen). 

Data Mining Module

Membership Module

Membership Package

Views: rpt_Membership_Package
rpt_Membership_Status_Per_Day

Member

Views: rpt_Membership_Member

Member Payment

Views: rpt_Membership_Member_Payment

Link using

“Package Id”

field

Link using

“Member Id”

field

Dynamic Data Sections

Views: rpt_Membership_*_Section

Notes:

· These views are generated by the application and 
will be named to match the “Section Description”.

· Multiple lookup fields will be formatted to a 
comma-separated list

Link using

“Package Id”

field

Dynamic Data Sections

Views: rpt_Membership_Member_*_Section

Notes:

· These views are generated by the application and 
will be named to match the “Section Description”.

· Multiple lookup fields will be formatted to a 
comma-separated list

Link using

“Member Id”

field
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Document Register Module (Previously called Policy Module)

Document Information

Views: rpt_Document_Register_Detail

Policy Internal Information

Views: rpt_Document_Register_Detail_Policy_Internal
(previously called “rpt_Policy_Detail”)

rpt_Document_Register_Detail_Policy_Internal_Current_Policy_File
(previously called “rpt_Policy_Detail_Internal_Current_Policy_File”)

Policy External Information

Views: rpt_Document_Register_Detail_Policy_External
(previously called “rpt_Policy_Detail_External”)

rpt_Document_Register_Detail_External_Response_File
(previously called “rpt_Policy_Detail_External_Response_File”)

Dynamic Data Sections

Views: rpt_Document_Register_Detail_*_Section
(previously called “rpt_Policy_Detail_*_Section”)

Notes:

· These views are generated by the application and will be named to match the 
“Section Description”.

· Multiple lookup fields will be formatted to a comma-separated list

· Old generated dynamic data reporting views linked to the old Policy module 
will be replaced by the new reporting views generated under the Document 
Register module. The users who use the old dynamic data views will need to 
change their reports to be linked the new generated dynamic data views for 
Document Register.

Correspondence Information

Views: rpt_Document_Register_Detail_Correspondence

Using Link

“Document Id”

Field

Notes:

· The old Policy reporting views will remain accessible in the current release. However 

Polymorphic Solutions recommends that the users should migrate their existing reports 

in order to use the new Document Register reporting views as the old Policy reporting 

views will be phased out subsequently.
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Client Administration Module

Client Information

Views: rpt_Client_Admin_Client

Feature: Carer information

Views: rpt_Client_Admin_Carer
rpt_Client_Admin_Carer_Address
rpt_Client_Admin_Carer_Communication

Client Address and Communication

Views: rpt_Client_Admin_Client_Address
rpt_Client_Admin_Client_Communication

Feature: Next of Kin information

Views: rpt_Client_Admin_Next_Of_Kin
rpt_Client_Admin_Next_Of_Kin_Address
rpt_Client_Admin_Next_Of_Kin_Communication

Feature: Interpreter information

Views: rpt_Client_Admin_Interpreter
rpt_Client_Admin_Interpreter_Address
rpt_Client_Admin_Interpreter_Communication

Feature: Clinical information

Views: rpt_Client_Admin_Clinical_Information
rpt_Client_Admin_Clinical_Information_Diagnosis

Feature: Identification and Membership information

Views: rpt_Client_Admin_Clinical_Identification_Detail
rpt_Client_Admin_Clinical_Identification_Membership

Feature: Consent information

Views: rpt_Client_Admin_Consent_Details

Feature: Exit information

Views: rpt_Client_Admin_Exit_Information

Feature: Health Assessment and Care Plan information

Views: rpt_Client_Admin_Health_Assessment_And_Care_Plan_Details

Feature: Counselling information

Views: rpt_Client_Admin_Counselling_Service
rpt_Client_Admin_Counselling_Referral

Feature: Counselling Session information

Views: rpt_Client_Admin_Counselling_Session

Dynamic Data Sections

Views: rpt_Client_Administration_*_Section

Notes:

· These views are generated by the application and 
will be named to match the “Section Description”.

· Multiple lookup fields will be formatted to a comma-
separated list

Link using 

“Client Id” field

Link Using 

“Referral Id”

field

Continue to the next page...
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Client Information

Views: rpt_Client_Admin_Client

Feature: Case Note Information

Views: rpt_Client_Admin_Case_Note

Feature: Case Note Additional Information

Views: rpt_Client_Admin_Case_Note_Associated_Data
rpt_Client_Admin_Case_Note_Contact_Organisation
rpt_Client_Admin_Case_Note_Pre_Save_File_Attachment
rpt_Client_Admin_Case_Note_Post_Save_File_Attachment

Notes:

· rpt_Client_Admin_Case-Note_Associated_Data & 
rpt_Client_Admin_Case_Note_Contact_Organisation can also be 
linked to the rpt_Client_Admin_Client using “Client Id” field.

Link Using “Client Id”

Link Using “Case Note Id” field

Feature: Case Note Dynamic Data Sections

Views: rpt_Client_Administration_Case_Note_Pre_Save_*_Section
rpt_Client_Administration_Case_Note_Post_Save_*_Section

Notes:

· These views are generated by the application and will be named to 
match the “Section Description”.

· Multiple lookup fields will be formatted to a comma-separated list

Link Using

“Case Note Id”

or

“Client Id”

field
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MSOAP Module

Service Information

Views: rpt_MSP_Service

Service Location Information

Views: rpt_MSP_Service_Location

Service Budget Information

Views: rpt_MSP_Service_Budget

Notes:

· The [Rate Is Permanent] field has been 
removed.

· Introducing new field called [Rate 
Contributes to Upskilling].

· [Rate Is Fixed] field has been renamed 
to [Rate Is Fixed or Variable] and returns 
text value of “Fixed” or “Variable”.

· [Rate Is Per Visit] field has been 
renamed to [Rate Is Per Visit or Per 
Contract] and returns text value of “Per 
Visit” or “Per Contract”

Service Specialist Information

Views: rpt_MSP_Service_Specialist

Service Visit Information

Views: rpt_MSP_Service_Visit

Professional Type, Type of Service, and 
Upskilling Information

Views: rpt_MSP_Service_Visit_Professional_Support_Type
rpt_MSP_Service_Visit_Type_Of_Service
rpt_MSP_Service_Visit_Upskilling

Invoice Information

Views: rpt_MSP_Service_Visit_Invoice

Link Using

“Service Id”

Field

Link

Using 

“Visit Id”

Field 

Dynamic Data Sections

Views: rpt_MSP_*_Section

Notes:

· These views are generated by the 
application and will be named to match the 
“Section Description”.

· Multiple lookup fields will be formatted to a 
comma-separated list

Invoice Payment

Views: rpt_MSP_Service_Visit_Invoice

Link Using

“Service Budget Id”

Field

Link Using 

“Invoice Id” Field

Link

Using

“Service Id”

field
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Using Link

“Meeting Id”

Field

Representation Module

Representation Information

Views: rpt_Representation

Representation Information

Views: rpt_Representation

Representation Information

Views: rpt_Representation

Representation Information

Views: rpt_Representation

Representation File Information

Views: rpt_Representation

Representation Meeting File Information

Views: rpt_Representation

Representation Nomination File Information

Views: rpt_Representation

Using Link

“Nomination

Id” Field

Using Link

“Representation 

Id”

Field

Using Link “Representation Id” Field

Quality Improvement Module

Quality Improvement Information

Views: rpt_Quality_Improvement_Details

Dynamic Data Sections

Views: rpt_Quality_Improvement_*_Section

Notes:

· These views are generated by the application and 
will be named to match the “Section Description”.

· Multiple lookup fields will be formatted to a 
comma-separated list

Related Quality Improvement Item Information

Views: rpt_Quality_Improvement_Related_Items

Using Link

“Quality 

Improvement Id”

Field
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Case Management Module

Process Definition Information

Views: rpt_Case_Management_Process_Definition

Process Definition – Phase Information

Views: rpt_Case_Management_Process_Definition_Phase

Process Definition – Activity Information

Views: rpt_Case_Management_Process_Definition_Activity

Case - Activity Information

Views: rpt_Case_Management_Activity

Case - Phase Information

Views: rpt_Case_Management_Phase

Case Information

Views: rpt_Case_Management_Case

Case History Information

Views: rpt_Case_Management_Case_History

Case Note Information

Views: rpt_Case_Management_Case_Note

Dynamic Data Sections

Views: rpt_Case_*_Section

Notes:

· These views are generated by 
the application and will be 
named to match the “Section 
Description”.

· Multiple lookup fields will be 
formatted to a comma-
separated list

Using

Link

“Case Id”

Field

Using Link

“Process Id”

Field

Using Link

“Phase Id”

Field

Using Link

“Case Id”

Field

Using Link “Phase Id” Field
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